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Volume 1: Embedded Systems, Introduction to ARM Cortex-M Microcontrollers,  

2016, ISBN: 978-1477508992 
 TM4C123, EE319K 

Keil or CCS projects 
MOOC on edX  
http://users.ece.utexas.edu/~valvano/arm/outline1.htm 
TM4C123 Lab in bag (Larissa made them) 

 
Volume 1: Embedded Systems, Introduction to the MSP432 Microcontroller,  

2015, ISBN: 978-1512185676  
MSP432,  
New robot curriculum September 2017 
Keil or CCS projects 

 http://users.ece.utexas.edu/~valvano/arm/msp432.htm 
 
 
Volume 2: Embedded Systems, Real-Time Interfacing to ARM Cortex-M Microcontrollers  

2016, ISBN: 978-1463590154 
 TM4C123 or TM4C1294,  

EE445L class at University of Texas at Austin 
 Set of lecture notes and lab assignments  
 http://users.ece.utexas.edu/~valvano/arm/outline.htm 
 
 
Volume 2: Embedded Systems, Real-Time Interfacing to the MSP432 Microcontroller  

2016, ISBN: 978-1463590154 
MSP432 
CCS projects 

 http://users.ece.utexas.edu/~valvano/arm/msp432.htm 
 
Volume 3: Embedded Systems, Real-Time Operating Systems for ARM Cortex-M Microcontrollers 

2017, ISBN: 978-1466468863 
 TM4C123, TM4C1294, and MSP432 

Keil or CCS projects 
 edX MOOC on TM4C123 and MSP432 

EE445M class at University of Texas at Austin 
 Set of lecture notes and lab assignments  
 
 

   

Labs 
 Switches and LEDs 
 Design and Debugging 
 Finite State Machine 
 Interrupts 
 DAC output  
 LCD graphics interface 
 Fixed-point 
 ADC input 
 UART and distributed 
 Capstone design - video game 

Labs 
 Graphics device driver 
 Alarm clock 
 Stepper or DC motor 
 Music player 
 Temperature acquisition 
 Wifi and IoT 
 PCB, Power 
 Capstone design 

 

 Labs 
 Memory manager, device driver 
 Thread switching RTOS 
 Blocking semaphores 
 Priority scheduler 
 Digital and analog filters, FFT 
 Digital control systems 
 File system 
 CAN or Ethernet network 
 BLE 
 Autonomous robot racing
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Embedded System Education – Real Time Operating Systems 
Hardware 
0) MSP432 LaunchPad (MSP-EXP432P401R) 
1) MKII Educational Boosterpack (BOOSTXL-EDUMKII)  
 
Install Software 
0) Install Code Composer Studio 7 (configure for MSP432) 

http://www.ti.com/tool/CCSTUDIO  
1) Install TI RTOS (configure for MSP432)  

http://www.ti.com/tool/TI-RTOS  
2) This ASEE workshop example code (unzip into a location easy to find) 

http://edx-org-utaustinx.s3.amazonaws.com/UT601x/Valvano_TI_RTOS.zip  
This workshop PowerPoint http://users.ece.utexas.edu/~valvano/ASEE2017.pdf   

 
Optional Software with lots of examples 
0) MSPware (MSP432 examples from TI) http://www.ti.com/tool/mspware  
1) edX MOOC examples (RTOS+BLE)  

http://edx-org-utaustinx.s3.amazonaws.com/UT601x/RTOSsoftware.html  
2) Valvano examples (MSP432 examples for books)  
 http://users.ece.utexas.edu/~valvano/arm/downloadmsp432.html  
 
Documentation 
0) MSP432 http://www.ti.com/ww/en/launchpad/launchpads-msp430-msp-exp432p401r.html  
1) TI RTOS http://www.ti.com/tool/TI-RTOS  
2) MKII http://www.ti.com/tool/boostxl-edumkii  
 
Configure jumpers, boards 
0) On MSP432 LaunchPad leave in all jumpers; the USB cable is needed. Line up the silk 
screens. Connect MSP432+MKII boards. Double check for alignment before powering 

         

http://www.ti.com/tool/CCSTUDIO
http://www.ti.com/tool/TI-RTOS
http://edx-org-utaustinx.s3.amazonaws.com/UT601x/Valvano_TI_RTOS.zip
http://users.ece.utexas.edu/%7Evalvano/ASEE2017.pdf
http://www.ti.com/tool/mspware
http://edx-org-utaustinx.s3.amazonaws.com/UT601x/RTOSsoftware.html
http://users.ece.utexas.edu/%7Evalvano/arm/downloadmsp432.html
http://www.ti.com/ww/en/launchpad/launchpads-msp430-msp-exp432p401r.html
http://www.ti.com/tool/TI-RTOS
http://www.ti.com/tool/boostxl-edumkii
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1) Plug LaunchPad USB into PC and observe the drivers in 
the device manager 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
Demo: WorldShapers_TIRTOS_MSP432 project 
1) Open Code Composer Studio Execute File-
>Switch Workspace choose Other…  
Browse, find the folder with Valvano_TI_RTOS 
and click OK 
 
 
 
 
 
2) Execute Project->Import CCS Projects, 
Browse for folder, Select them all, Click Finish 
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3) See how the project connects to TI RTOS,  
click project, open Includes 

 
 
4) See low level I/O functions for MK-II, open BSP.c 
 Written in “Valvano style” 
 
5) See high-level game engine, open WorldShapersMain.c 

• Three main threads “thread” 
o Look like main programs 
o Have priority 

• I/O-triggered thread “task” 
o Looks like an interrupt service routine 

• Search for “thread” 
o Use sleep to cooperate 

•  MoveEnemiesThread (low priority) 
o Implements AI of enemies 

•  GameThread (middle priority) 
o Execute player dynamics 
o Runs about 30 Hz 

•  SoundThread (high priority) 
o Outputs sound to buzzer 
o Runs at 1.4 kHz 

• Search for “SlowPeriodicTask” 
o Triggered by periodic clock 
o Looks like an ISR 

• Search for “stack”  
o Each thread has its own stack 

• Search for “main” 
o See how four threads are created 

• Search for “semaphore” 
o Pend: decrement counter, block if <0 
o Post: increment counter, wake up one block if needed 

Your Application

TCP/IP

Real-Time OS Kernel

Microcontroller Target

Standardized cross-platform APIs

USB,
MSC,
HID,
CDC

FAT
File

System

IPC
Multicore

comm

Debug and Instrumentation

I/O drivers

Note: 
Run WorldShapers_TIRTOS_MSP432 
not Lab4_WorldShapers-MSP432 

R0
R1
...

SP
PC
PSR

Stack

Program

Thread

R0
R1
...

SP
PC
PSR

Stack

Program

Thread

R0
R1
...

SP
PC
PSR

Stack

Program

Thread

void Thread1(void){ 
  Init1(); 
  while(1){ 
    Semaphore_pend(MutexHandle); 
     // exclusive access 
  
    Semaphore_post(MutexHandle); 
    // other processing 
   } 
} 

void Thread2(void){ 
  Init2(); 
  while(1){ 
    Semaphore_pend(MutexHandle); 
     // exclusive access  
  
    Semaphore_post(MutexHandle); 
    // other processing 
   } 
} 
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o construct 
 
 
6) Debug 

• Build 
o Compile and link 

 
 

• Debug 
o Download and debug 

 
 
 
 
 
 

• Run 
 
 

• Edit 
o Quit 
o Edit line 592 in Intermission(),  
o Edit lines 110-114, reducing the KillCount to make game easier 
o Build, debug, run! 

 
Additional Resources: 
Embedded Systems MOOC 
https://www.edx.org/course/embedded-systems-shape-world-utaustinx-ut-6-10x 
https://www.edx.org/course/embedded-systems-shape-world-multi-utaustinx-ut-6-20x 
http://users.ece.utexas.edu/~valvano/Volume1/E-Book/VideoLinks.htm 
Real-time Bluetooth MOOC 
https://www.edx.org/course/real-time-bluetooth-networks-shape-world-utaustinx-ut-rtbn-12-01x  
http://edx-org-utaustinx.s3.amazonaws.com/UT601x/RTOS.html 
ASEE 2015 Resources (wifi) 
2015 Workshop PowerPoint  http://users.ece.utexas.edu/~valvano/ASEE2015.pdf  
2015 Workshop Server code  http://users.ece.utexas.edu/~valvano/ASEE2015.zip   
2015 Workshop server   http://embedded-systems-server.appspot.com/  
2015 Workshop map   http://embedded-systems-server.appspot.com/map  
MOOC server    http://embsysmooc.appspot.com/  
MOOC map    http://embsysmooc.appspot.com/map  
ASEE 2016 Resources (BLE) 
2016 Workshop PowerPoint  http://users.ece.utexas.edu/~valvano/ASEE2016.pdf  
2016 Workshop projects code  http://edx-org-utaustinx.s3.amazonaws.com/UT601x/BLE.zip  
 Valvano Example code 
  Valvano home page   http://users.ece.utexas.edu/~valvano/  
  Individual projects     http://users.ece.utexas.edu/~valvano/arm/  
  ValvanoWareTM4C123 folder    http://tinyurl.com/nuq4zpx    
  LaunchPad tester   http://users.ece.utexas.edu/~valvano/arm/tester/  

http://users.ece.utexas.edu/%7Evalvano/ASEE2015.pdf
http://users.ece.utexas.edu/%7Evalvano/ASEE2015.zip
http://embedded-systems-server.appspot.com/
http://embedded-systems-server.appspot.com/map
http://embsysmooc.appspot.com/
http://embsysmooc.appspot.com/map
http://users.ece.utexas.edu/%7Evalvano/ASEE2016.pdf
http://edx-org-utaustinx.s3.amazonaws.com/UT601x/BLE.zip
http://users.ece.utexas.edu/%7Evalvano/
http://users.ece.utexas.edu/%7Evalvano/arm/
http://tinyurl.com/nuq4zpx
http://users.ece.utexas.edu/%7Evalvano/arm/tester/


Embedded, RTOS, and IoT
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• Market share
• Complexity
• Parallelism 
• Verification

• Cathy Wicks, c-wicks@ti.com
• Jonathan Valvano, valvano@mail.utexas.edu
• Daniel Valvano
• Mark Easley
• John Gracia

Why ARM M4?



Outline

1. LaunchPad ecosystem (Mark)
2. Demonstrations (All)

– Unpack and blink
– TI-RTOS
– Questions and answers

3. Embedded System Education (Jon)
– Courses, Books and Labs
– Competitions

4. IoT Demonstration (Mark) 2



TI LaunchPad™
20/40‐pin Standardized Pinout
 Add BoosterPack
 Jumper to your own hardware
 BYOB – Build Your Own Boosterpack

Segmented Display (LCD)
Available on some LaunchPads

User LEDs

Isolation Jumper
Let’s you isolate Target
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LaunchPad is TI’s Common Denominator

TI Wireless: Sub-1GHz, NFC/RFID, Wi-Fi, ZigBee, BLE, Bluetooth

Analog, sensors, displays & more from TI, 3rd parties & Maker 
community

Modular hardware enables developers to explore new ideas quickly

MSP430
(Ultra-Low Power)

TM4C
(ARM Cortex M4F)

C2000
(Real-time Control)

Hercules
(Safety)

LaunchPads featuring TI MCUs & BoosterPack interface

CC3200 
(MCU + WiFi)



TI LaunchPad
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• Students should have their own board

MSP432 LaunchPad $13
TM4C LaunchPad $13
Connected LP $20



RTOS demonstration overview
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• Configure Code Composer Studio
• Import examples into workspace

• TI RTOS
• WorldShapers_TIRTOS_MSP432

• Threads, stacks
• Hardware-triggered tasks
• Semaphores

CCS and TI-RTOS are already installed



MSP432-EDUMKII

7System Bus

four
UART

24
channels
ADC14

eight
SPI

four
TimerA

four
I2C

Timer32

RTC

GPIO/SSI

Cortex M4 64k RAM

P1.5
P5.0
P1.6
P5.7
P3.7

LCD

P5.6
P2.4
P2.6

LED
GPIO

P2.7 Buzzer
PWM

P1.3
P1.2 PC/grader

UART

P3.3
P3.2 Bluetooth

UART

GPIO/I2C

GPIO

Analog

Buttons P3.5
P5.1

P4.6
P6.5
P6.4
P3.6

Light

Temperature

P4.3

P6.0
P4.4
P4.1

P6.1
P4.0
P4.2

Microphone

Joystick

Accelerometer

Analog

Analog

0) Unpack LaunchPad and MKII
1) Connect MKII to LaunchPad



MSP432 Drivers
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2) Open Device Manager
3) Connect LaunchPad USB to PC 
and power up the two boards
4) Watch installation
Make note of the COM port



Configure CCS
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File->Switch Workspace
choose Other…



Configure CCS
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2) Select all  
C:\Users\Administrator\Desktop\Valvano_TI_RTOS

3) OK

1) Browse  



Configure CCS
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1) Project->Import CCS Projects

2) Click them all

3) Click Finish

WorldShapers_TIRTOS_MSP432



Debug
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• Build
– Compile and link

• Debug
– Download and starts debugger

• Run

• Play game
• Quit debugger



WorldShapers_TIRTOS_MSP432

• See how project links 
to TI RTOS
– Open Includes

Derived from a 
TI RTOS example project

13



TI-RTOS
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CCS and TI RTOS are already installed

Your Application

TCP/IP

Real-Time OS Kernel

Microcontroller Target

Standardized cross-platform APIs
USB,
MSC,
HID,
CDC

FAT
File

System

IPC
Multicore

comm

Debug and Instrumentation
I/O drivers

You can teach
Applications
Interfacing
RTOS



WorldShapers_TIRTOS_MSP432
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• BSP.c
– My I/O drivers for EDUMKII

• WorldShapersMain.c
– 3 main threads
– 1 periodic task
– Semaphore used for mutual exclusion

Teach interfacing

Use RTOS to teach applications



Threads
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• Three main threads “thread”
– Look like main programs
– Have priority

• I/O-triggered thread “task”
– Looks like an interrupt 

service routine

R0
R1
...

SP
PC
PSR

Stack

Program

Thread
R0
R1
...

SP
PC
PSR

Stack

Program

Thread
R0
R1
...

SP
PC
PSR

Stack

Program

Thread



WorldShapersMain.c
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• Search for “thread”
– Manage: timeout, sleep, wait on event, kill

• MoveEnemiesThread (low priority)
– Implements AI of enemies

• GameThread (middle priority)
– Execute player dynamics
– Runs about 30 Hz

• SoundThread (high priority)
– Outputs sound to buzzer
– Runs at 1.4 kHz



WorldShapersMain.c
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• Search for “SlowPeriodicTask”
– Triggered by periodic clock
– Looks like an ISR

• Search for “stack”
– Each thread has its own stack

• Search for “main”
– See how four threads are created



Semaphores
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• Semaphore_pend
– Decrement counter
– Block if < 0

void Thread1(void){
Init1();
while(1){

Semaphore_pend(MutexHandle);
// exclusive access

Semaphore_post(MutexHandle);
// other processing

}
}

void Thread2(void){
Init2();
while(1){

Semaphore_pend(MutexHandle);
// exclusive access 

Semaphore_post(MutexHandle);
// other processing

}
}

•Semaphore_post
– Increment counter
– Wake up one blocked if needed

Search for “semaphore”
• pend
• post
• construct



Change the loading screen
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• Edit line 592
– Add your name

• Build
• Debug
• Run

• Questions?



Educational Objectives

21

• Outcomes, Measureables
• Career opportunities
• Economic growth
• Student feedback

• Educational effectiveness
• Improved performance
• Reduced resources

• Educational team

Embedded Systems

MEEE

CSBME Civil

Aero

Why are 
we here?



Takeaway: Bottom up (what?)
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• Bottom up: From simple to complex
• Transistors → Gates → Computer → Systems
• Assembly → C → Java/C++ → LabVIEW

• Abstraction
• Understand → Put it in a box → Use the box

• Systems
• Take two systems→ Connect → New system+



Takeaway: See one, do one, teach one
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• Equipment must work
• Assignments must be clear
• Assignments must be relevant
• Tasks support learning objectives
• Professors must do labs

Students learn by doing

Students learn by teaching



Takeaway: Empower Students
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• Students should have their own DVM
• Show labs to friends and parents
• Encourage them to work beyond lab

• Find sources of free parts
• Give simple stuff away

• Mentor their careers
• Job versus grad school
• Online presence

Students need to learn outside of  lab



Courses, Books, and Labs
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Introduction to Embedded Systems
Freshman, MOOC

System Level Design
Junior, PCB, IoT

Real-time Operating Systems
Senior/grad ,CAN, Robot

• Cortex-M4
• serial, SPI, ADC,
• timer, PWM, DMA
• interrupt controller
• JTAG debugger
• floating point 

$13EK-TM4C123GXL, 43 I/O pins, 32k RAM, 256k RAM, 80 MHz, USB, CAN
EK-TM4C1294XL, 90 I/O pins, 256k RAM, 1M ROM, 120 MHz, Ethernet
MSP-EXP432P401R, 67 I/O pins, 64k RAM, 256k ROM, 48 MHz, low power 

$20
$13



Applications
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• Compiler, Simulator, Debugger
• TI: Code Composer Studio
• Keil uVision
• TExaS (simulation, grading, LA, scope)

• Circuit design and PCB layout
• PCB Artist
• Eagle (100 by 80 mm, 2 layers)
• Circuit Maker (Altium)

• Design tools
• TI: WEBENCH,  Filter Pro



Introduction to Embedded Systems
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Volume 1 (freshmen EE or BME)
• Switches and LEDs
• Design and Debugging
• Finite State Machine
• Interrupts
• DAC output 
• LCD graphics interface
• Fixed-point
• ADC input
• UART and distributed
• Capstone design - video game

• Assembly or C programming
• Design and Debugging

– Simulation, logic analyzer, scope

9,295 sold, 507 pages, $34



Embedded Systems – Shape the World
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• What is and isn’t a MOOC?
– Spring 14, 15, 16, 17
– over 110,000 enrolled
– over 2.5 million video hits
– over 7% got certificates 
– 2/3 who started, finished
– 95% approval rate

• Lab kit + Teaching videos
• LaunchPad simulator, graders, voltmeter, scope
• Have done both Wifi and BLE in MOOC

Physical kit increased completion rates



Interfacing and Systems

29

Volume 2 (junior EE)
• Graphics device driver
• Alarm clock
• Stepper or DC motor
• Music player
• Temperature acquisition
• Wifi and IoT
• Capstone design - open 
ended, PCB, Power

• Hardware/software debugging
• Design and debugging
• Analog, power, computer

4,274 sold, 600 pages, $44



Real-Time Operating Systems
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Volume 3 (senior/grad EE)
• Memory manager, device driver
• Thread switching RTOS
• Blocking semaphores
• Priority scheduler
• Digital and analog filters, FFT
• Digital control systems
• File system
• CAN or Ethernet network
• Autonomous robot racing

MOOC starting 9/2017 on edX http://ow.ly/ophC301Aa0p

3,061 sold, 485 pages, $30



Support for teaching
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Website (download and edit)
• Examples for TM4C123, TM4C1294, MSP432
• PowerPoint slides
• Lab manual, data sheets
• http://users.ece.utexas.edu/~valvano/

LaunchPad tester

http://users.ece.utexas.edu/~valvano/arm/tester/

edX: Intro until Dec, RTOS-BLE Fall 2017

http://ow.ly/ophC301Aa0p

Adopt a book →
Free parts for LaunchPad tester



Support for teaching on university.ti.com 

32

Robotic System Education (Fall 2017)
• MSP432+Robot
• PowerPoint slides
• Lab manual, data sheets
• Quizzes
• CCS software projects
• Sensors
• Motors
• IoT/BLE



Support for teaching on university.ti.com
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Robotic System Education (Fall 2017)
• Systems approach
• Aggregate components
• Explorer robot
• Introduction

– Volume 1
– No Calculus

• Intermediate
– Volume 2
– Circuits
– Signal processing



Successes: Competitions
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• Appropriate use of teams
• Build things that are fun to play with

• Show off to friends, family, interviewers
• Competitions

• Fun, intense
• Open-ended

• Creativity, life-long learning, springboard

Students need to appreciate relevance



Competition
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Volume 1 (freshmen EE or BME)
• Handheld game, peer review
Volume 2 (junior EE)
• Design cycle, testing, systems
Volume 3 (senior/grad EE)
• Autonomous Robot Racing

http://youtu.be/QxDQUUDStOw
http://youtu.be/z6_jlM2Y5qI
http://youtu.be/K9FD50qpGwg

http://youtu.be/bZ1fXtN1T08
http://youtu.be/GKctvlvprAQ



Competitions
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http://youtu.be/bZ1fXtN1T08
http://youtu.be/GKctvlvprAQ

https://youtu.be/0ZOI5AGtdf0



Conclusions
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• Bottom-up
• Lab-centered
• Empower students
• Motivate students
• Be flexible
• Be a team builder
• Make a plan and do it

Understanding
Design
Innovation



IoT Demonstration (Mark)
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• Temboo + TI LaunchPad
• View full workshop at https://goo.gl/VbymuW



For more information
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Jonathan Valvano valvano@mail.utexas.edu
http://users.ece.utexas.edu/~valvano/

EE319K Introduction
EE445L Interfacing and systems
EE445M Real-time operating systems

https://www.edx.org/course/embedded-systems-shape-world-utaustinx-ut-6-10x
https://www.edx.org/course/embedded-systems-shape-world-multi-utaustinx-ut-6-20x
http://users.ece.utexas.edu/~valvano/Volume1/E-Book/VideoLinks.htm
http://edx-org-utaustinx.s3.amazonaws.com/UT601x/RTOS.html

Mark Easley 
Cathy Wicks univ@ti.com


